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ABSTRACT

Alzheimer’s disease (AD) is a neurodegenerative disease caused by the accumulation of
amyloid-beta (AB) in the brain. Our laboratory previously established an in vitro model for AD
by treating cultured human neuronal cells with A3, and showed that neuronal survival could be
restored by treating the cells with a neurotrophic factor (NTF) mimetic. The purpose of this
MQP is to expand the tests in vivo using 3X transgenic Alzheimer’s mice to analyze AD mouse
behavior. This project developed a procedure for performing the Morris water swimming test in-
house at WPI, and determined whether this test can distinguish WT from AD behavior at 4
months of age, one month past the age at which they first show brain alterations. The data
indicate that at 4 months of age, this AD strain is indistinguishable from WT mice in the Morris
test. In preparation for future in vivo tests with various NTF peptides, we also compared the
activity of a variety of Ap batches on human neuronal cell morphology using the in vitro AD
model, and conclude that all Ap batches induced significant morphological alterations relative to

untreated control cultures.
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BACKGROUND

Alzheimer’s Disease

Alzheimer’s disease (AD) is a neurodegenerative disorder that causes problems in logic,
memory, and behavior. As the most common type of dementia, AD can eventually impair an
individual’s ability to perform the simplest functions such as walking and swallowing and is
ultimately fatal (Alzheimer's Association, 2012). Accounting for an estimated 60-80% of
dementia cases, it causes healthy brain cells to lose their function and communicate with each
other and eventually die. Its prevalence is increasing, with an estimated 115 million expected to
be diagnosed worldwide by 2050 (Alzheimer’s Association, 2012). AD is the 6™ leading cause of
death in the United States, and the 5" leading cause of death for people 65 years and older
(Alzheimer’s Association, 2012). There are no known preventions or cures, and until recently

the only definitive method of diagnosis was a post-mortem autopsy.

AD Symptoms

The first clinical symptoms of AD are often memory loss, such as difficulty in
remembering names and events, and other cognitive problems, such as trouble with language and
decision-making (Alzheimer’s Disease Progress Report, 2011). Early symptoms also include
apathy and depression. AD patients progress from mild to moderate to severe stages of the
disease at different rates. In the late stages, symptoms include impaired judgment, disorientation,

confusion, personality and behavior changes, and difficulty speaking, swallowing, and walking.



Histological Characteristics of AD

The hallmark characteristics of AD brains are extracellular senile plaques, that are
deposits of the protein fragment amyloid-beta (AP), and intra-neuronal neurofibrillary tangles,
that are twisted strands of tau protein (Selkoe, 2001). These two cellular features became the
very first diagnostic criteria of the disease as they were first visualized by a young and
accomplished German doctor named Alois Alzheimer in brain slices of the first diagnosed
patient, Auguste Dieter, who had an early onset version of the disease.

AP is formed by the cleavage of amyloid precursor protein (APP) by gamma- and beta-
secretase enzymes. Intracellular neurofibrillary tangles are formed from hyper-phosphorylated
tau proteins that dissociate from microtubules (Kawashima and lhara, 2002). Although both
amyloid plaques and neurofibrillary tangles are present in low amounts in all normal aging
individuals, accumulation of these two features can lead to AD (Munoz and Feldman, 2000;
Kawashima and lhara, 2002).

Additionally, in AD patients, synaptic connections between groups of neurons stop
functioning and begin to degenerate in large numbers. As networks of neurons lose their
connections, break down, and die throughout the brain, affected regions begin to shrink in a
process known as brain atrophy (Alzheimer’s Disease Progress Report, 2011). Cerebral atrophy
is a characteristic of AD (Figure 1). However, this loss of both gray and white matter is not
enough to diagnose AD because it does not distinguish between normal ageing and the disease
(Munoz and Feldman, 2000). Until recently, the only definitive way to diagnose AD involved a
post-mortem autopsy to demonstrate the presence of high levels of amyloid plaques and

neurofibrillary tangles in the brain (Luchsinger and Mayeux, 2004).



Figure-1: Photograph of a Normal Human Brain (upper) and an AD
Brain (lower). Note the appearance of areas of the AD brain with loss of
gray and white matter. (Sanders, 2011)

Amyloid plaques, neurofibrillary tangles, synaptic loss, and cell death are the most
prominent features of the AD brain. However, scientists are also discovering many other cellular
changes that occur in the brain of AD patients. Signs of inflammation in response to cellular
injury, brain blood vessel and neuron degeneration in response to neuronal malfunction, and
abnormal glial cells have been observed in AD patients (Alzheimer’s Disease Progress Report,

2011).

Alzheimer’s Cell Biology

The most widely held model for cell death in AD is known as the Amyloid Cascade
Hypothesis (Figure-2) (Selkoe, 2001; Masters et al., 2006). The amyloid cascade hypothesis
states that AD begins with the extracellular formation and deposition of neurotoxic Ap, a 40-42
amino acid peptide derived from the proteolytic cleavage of amyloid precursor protein (APP) by
cleavage with beta- and gamma-secretase enzymes (diagram upper left). This peptide forms
especially in the regions of the brain responsible for memory and cognition, the pre-frontal
cortex and the hippocampus. The toxic effects of AR are caused by its interaction with the
receptor for advance glycation end products (RAGE) (Yan et al., 1996). This interaction causes

reactive oxidative stress (ROS) in the brain (diagram center). AD patients also have a higher



RAGE expression in the cortex and hippocampus, which creates a positive feedback loop for
increased binding to AP (Yan et al., 1996). The ROS causes a variety of cellular problems,
including lipid peroxidation and membrane depolarization (diagram right), activation of
apoptotic kinases (lower left), and tau hyperphosphorylation (lower center). Although initially
the AD research field was divided into two camps, the AR camp arguing that AR was the cause
of the disease, and the Tau camp arguing that Tau causes AD, we now know that A initiates
AD and tau is a required downstream event. Mice lacking AB but containing tau do not get AD,
and transgenic mice containing Ap and missing tau do not proceed to full AD, so both are
necessary (Rapoport et al., 2002; Robertson et al., 2007). Other characteristics induced by AB
include calcium disruption, mitochondrial dysfunction, metabolic interferences, and protein
misfolding, all of which help activate apoptosis. Once initiated, the ROS and neurofibrillary

tangles spread to other areas of the brain.
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Figure-2: Diagram of the Amyloid Cascade Hypothesis for Alzheimer’s Disease. In this
hypothesis, the formation of AB (yellow, upper left) by cleavage from the amyloid precursor
protein (green, upper left) initiates the formation of cellular oxidative stress (ROS, orange).
Downstream, tau hyper-phosphorylation (red) leads to the disassembly of axonal microtubules,
weakening the synapse. (Derived from Adams Review,; Jackson and Najem, 2012)



Evidence strongly supporting the Amyloid Cascade Hypothesis was recently obtained
from an analysis of the Icelandic genetic database, where a mutation was identified in APP that
appears to protect individuals from getting AD (Jonsson et al., 2012). The mutation blocks the
production of AR, and even aged individuals containing the mutation do not get AD, so this
finding supports the hypothesis that Ap causes AD. Individuals containing the mutation lack Ap
from birth, so questions remain whether lowering AR later in life can block the disease. But this
significant finding has excited researchers to continue identifying more drugs that affect A3
production, and has led to several clinical trials for blocking AR formation earlier in patients

(see clinical trials).

Current AD Treatments

Several drugs have received FDA approval for treating AD, but these treatments only
temporarily relieve the AD symptoms, they do not cure or treat the underlying
neurodegeneration. The five currently approved drugs for treating AD are: Donepezil (Aricept),
Galantamine (Razadyne), Rivastigmine (Exelon), Tacrine (Cognex), and Memantine (Namenda).
The first four are acetycholinesterase (AChE) inhibitors, while Namenda is an NMDA (N-
methyl-D-aspartate) modulator that decreases excitotoxic glutamate. The AChE inhibitors block
the enzyme that breaks down acetylcholine (a neurotransmitter that helps in memory formation)
thereby increasing the levels of acetylcholine in the synapse, but the benefits are temporary
(Adams, 2013). These drugs only help AD patients perform daily activities, and may temporarily
aid symptoms related to logic, memory, and speaking (Alzheimer’s Disease Progress Report,

2011).



Future AD treatments in clinical trials (discussed below) are being researched attempt to
slow the disease and inhibit AD progression. Because A plays a central role in AD, current
strategies aim to block toxic AP formation, remove existing AP, or reverse AB-induced
neurodegeneration (Adams, 2013). Other lesser-known research areas devoted to AD treatment
strategies include treating tau tangles, targeting apolipoprotein E gene (APOE), using anti-
inflammatory drugs, and using drug combinations.

Due to the common acceptance of the amyloid cascade hypothesis, a large amount of
research is devoted to AP modulation. Altering toxic AP can be achieved through inhibition of
beta or gamma secretase proteins in the brain, or Ap itself can be modulated to prevent its
aggregation into the toxic oligomers that strongly contribute to the neurodegeneration. Merck has
developed a gamma-secretase inhibitor that went into clinical trials (see below), while Purdue
University has patented a beta-secretase inhibitor. Elan Pharmaceuticals is working on
developing an AD vaccine that removes existing AP plaques. Additionally, David Adams
laboratory focuses on using neurotrophic factors for regenerating the brain following
neurodegeneration (Adams, 2013). Unfortunately, the search for a true disease-modifying AD
treatment continues, and the world remains relatively far away from having a commercial

treatment.

AD Clinical Trials

Although AP has been shown to initiate AD, clinical trials to block its formation by
blocking gamma-secretase (Merck), or by removing existing AB (Elan Pharmaceuticals, Pfizer’s
bapineuzumab, Genentech’s crenezumab, Eli Lily’s solanezumab) failed in Phase 11 clinical

testing. Scientists who argue against the amyloid cascade hypothesis claim these failures prove
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that AR is not a cause of AD, or the patient’s cognition would have improved. But proponents of
the cascade hypothesis point out that the treatments were only initiated very late in the patient’s
prognosis, perhaps far too late for Ap removal to do any good. Thus, three upcoming clinical
trials, expected to begin this year, will attempt to prevent dementia much earlier in AD patients
by treating early-onset individuals known to be at risk for the disease decades before they
develop symptoms (Miller, 2012). Families with an inherited form of AD will be targeted in their
30’s instead of their 70’s. One trial is affiliated with the Dominantly Inherited Alzheimer
Network (DIAN), another trial is led by the Alzheimer’s Prevention Initiative (API), and the
third is termed the Anti-Amyloid Treatment of Asymptomatic Alzheimer’s (A4) (Miller, 2012).

The DIAN trial will contain 240 participants who have mutations in any of the three
genes linked to early-onset AD: PSEN1, PSEN2, or APP. The first stage of the trial will test
three anti-amyloid treatments, the exact drugs have yet to be determined, which will target Ap by
either slowing its production or clearing it from the brain (Miller, 2012). The initial phase will
assay several biomarkers to identify the most promising drug candidate for a follow-up phase to
examine cognitive effects (Miller, 2012). Recent work by DIAN researchers show that A}
concentrations in cerebrospinal fluid dip up to 25 years before the onset of AD symptoms (as AR
accumulates in the brain it appears to be removed from the CSF). Brain scans show amyloid
accumulation and atrophy at least 15 years prior to the onset of symptoms (Miller, 2012).
Therefore, researchers will monitor these levels and other biomarkers during the first stage of the
trial, which is scheduled to last 2 years (Miller, 2012).

Similarly, the API trial will be conducted in Colombia, South America, where 300
members of a very large Colombian early-onset family will participate. 100 members are known

to be carriers of the mutated PSEN1 gene (Miller, 2012). The API trial will test the drug
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crenezumab, an anti-amyloid antibody developed by Genentech. Crenezumab was chosen as the
candidate drug because animal studies suggest it effectively clears several different forms of Ap.
In addition, crenezumab was designed to avoid the harmful inflammatory side effects of other
anti-amyloid antibody treatments, such as swelling caused by cross-reactivity of the AB antibody
with APP, and micro-hemorrhages in the brain caused by leaky blood vessels (Miller, 2012). So
far, no evidence of these side effects have been observed in Genentech’s clinical trials in mild to
moderate AD patients. The drug will be used to measure changes in several cognitive tests, and
API researchers will collect biomarkers and brain scans to measure A accumulation and brain
atrophy in real time (see below) (Miller, 2012). The API trial is designed to last about 5 years.
Unlike the API and DIAN trials, trial A4 will take a different approach to prevent the far
more common non-genetic form of AD (Miller, 2012). This trial will include participants who
are 70 and older and who test positive on a scan for AR accumulation in the brain (Miller, 2012).
1500 healthy seniors will be used, of which 500 test positive for Ap on the scans (Miller, 2012).
500 of the AB-positive participants and 500 of the AB-negative elderly controls will take part in a
3-year trial that will track changes in cognition (Miller, 2012). The other 500 Ap-negative
participants will partake in a parallel study of aging and cognition (Miller, 2012). The API team
has yet to select the drug candidate, but is watching closely the bapineuzumab trials and phase 11l

clinical trials of solanezumab, an anti-amyloid antibody developed by Eli Lilly (Miller, 2012).

AD Diagnostics

The long held method for determining that a patient has AD is autopsy of the brain at
time of death to search for plagues and tangles. Prior to death and autopsy, a suspected patient
was said to have Alzheimer-type pathology by looking through the patient’s medical history,

physical exams, memory tests, and other mental assessments. But recent research has developed
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methods for detecting A in living patients, early and accurately. Biomarker tests and the use of
magnetic resonance imaging (MRI) scans for early AD diagnosis are two growing areas of
research generating promising results that can someday be used in general medical practice.

Biomarker tests measure a compound in the body that accurately indicates the presence
or absence of disease or the chance of developing the disease. Two major categories of
biochemical AD markers are cerebrospinal fluid (CSF) and plasma markers. Studies report
several CSF biomarkers showing consistent elevations in AD, as well as predicting the
conversion of normal to cognitive impairment. Combinations of CSF markers AB4, and tau have
proven particularly promising as potential diagnostic and prognostic biomarkers with accurate
sensitivity and specificity (Teunissen et al., 2002; Hampel et al., 2008). Plasma markers, on the
other hand, have provided mixed results. Most are unable to distinguish AD from controls, or
predict progression from MCI to AD. But some proteomic studies of plasma and serum are
promising (Teunissen et al., 2002; Hampel et al., 2008).

Along with biochemical markers, neuroimaging techniques are increasingly used to
detect brain changes associated with AD, and have potential use as markers of disease
progression, monitors of therapeutic effects, and predictors of future dementia prior to
symptoms. These imaging techniques include computed tomography (CT), magnetic resonance
imaging (MRI), functional MRI (fMRI), positron emission tomography (PET), and single photon
emission computed tomography (SPECT) (Mentis, 2000; Zhang et al., 2008; Vermuri et al.,
2010; Prvulovic et al., 2011). Each imaging technique appears to provide predictive value, and
the appropriate sensitivity and specificity. However, most imaging techniques are not ready for
widespread use. They are laborious and time-consuming, and are only used for clinical studies

and as an end point for treatment effects. PET has been shown to give an excellent distinction
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between controls and AD patients, and a combination of FDG-PET and PIB-PET shows promise
for distinguishing MCI and AD (Ramanan et al., 2013). However, other imaging markers need

further development for accuracy in the early diagnosis of AD.

Alzheimer’s Mouse Models

Other than higher primates, animals do not normally get AD, so models had to be devised
to test treatments. The original Alzheimer’s mouse model was created by Games et al. in 1995.
This PDAPP model used the PDGF promoter to express a variant of human amyloid precursor
protein found in an Indiana early-onset AD pedigree (Murrell et al., 1991). The variant caused
an increased expression of AR in the cortex, corpus callosum, and hippocampus at 5-14 times the
amounts in wild type mice (Games et al., 1995). The mice show age related memory loss,
synaptic loss, and reduction in size of the hippocampus, corpus callosum, and fornix, comparable
to AD patients (Kobayashi and Chen, 2005). The fact that young mice show an increase in A
but no hippocampal reduction supports the amyloid cascade hypothesis as AR being the initiator.

Since the original 1995 model, other models have been developed. A second AB-
producing mouse model was created by over-expressing the Swedish double mutant form of
human APP695 (Hsiao et al., 1996). These transgenic mice, called the Tg2576 mouse, are
similar to the PDAPP mice except they do not exhibit the synaptic loss or reduction in
hippocampal size. Many other transgenic mouse models also have been created, including
multiple gene transgenic mice, the first of which was developed to express mutated presenilins
and human APP (Holcomb et. al 1998). Presenilins are enzymes containing gamma-secretase

activity, and are required for the accumulation of AB1.42 (Brunkan and Goate, 2005)
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The transgenic mice used in this MQP (JAX stock #034843 or #007027) are 3X
transgenic for the human APP Swedish mutation K670N/M671L, the Dutch mutation E693Q,
and the Iowa mutation D694N, each of which is found in early-onset pedigrees and results in the
increased production of AB. The APP expression is under the control of the mouse thymus cell
antigen-1 Thyl promoter to ensure expression in the cortex, hippocampus, and corpus callosum.
The mice are commercially available from the Jackson Laboratory, and were originally
engineered by William Van Nostrand’s lab at Stony Brook University (Davis et al., 2004) in a
C57 background strain. The AD strain shows A plaque deposition beginning at 3 months of age
in the subiculum, hippocampus, and cortex. After 6 months of age, the plaques have spread to
the olfactory bulb and thalamic region. By 12 months of age, the plaques are found throughout
the entire forebrain. Due to the hardy nature of this strain, they can be bred as homozygotes,
eliminating the need for genotyping the offspring. The wild type C57 mice used as controls in
this MQP represent the same background as the AD, and are one of the most commonly used

inbred strains in biological research.

AD Mouse Model Behavior

Most of the successful AD mouse models show behavioral changes. The behavioral
alterations mimic those in AD patients, and can be used to monitor the efficacy of potential AD
therapies in the model. Only a few AD mouse behavioral studies have been performed to date
(Moran et al., 1995; Nalbantoglu et al., 1997; Chen et al., 2000; Boutajangout et al., 2010;
Cramer et al., 2012). Because AR production in the hippocampus alters memory, most of the
behavioral tests measure hippocampal-dependent spatial-based learning and memory, as is

altered in AD. Most of the tests showed conflicting results, including the rotarod test, general
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activity test, body temperature test, elevated maze test, and the novel objective recognition test.
However, some of the previous studies agree that the Morris water test is capable of
distinguishing WT from AD mice.

The Morris water maze is a sensitive test used to examine memory in rodents (Morris,
1984). Based on the few studies done so far with AD mice, this test appears to be the most
reliable for distinguishing AD from WT mice. It is particularly sensitive for hippocampal
function, one of the earliest and most affected brain regions in AD (Bryan et al., 2009). To
perform this test, in the training phase, the mouse is gently placed in a circular tank of room
temperature water and is timed as it searches to find a marked platform. In the subsequent phase,
the mice are timed as they locate a hidden platform, whose position has been moved relative to
the training phase. Several trials are performed daily, and the mice usually learn to find the
platform faster and with less distance traveled. Modern versions of the test use a camera and
computer software to track latency time, distance traveled, and time spent in each quadrant.
Using marked, unmarked, and probe trials (with no platform) the mouse’s ability to retrieve and
retain learned information can be tested.

Past studies using the Morris test have shown that AD mice show age-related deficits in
spatial learning (Moran et al., 1995). In the Moran 1995 study, no statistically significant
difference was found between 6-12 month old WT and AD mice in the initial visible platform
training phase, but in the 2nd and 3rd no platform probe trials, the WT mice searched the correct
training quadrant significantly more than the AD mice. This demonstrates that the AD mice
have deficits in memory affecting their ability to remember the location of the platform. While
all mice in general improve their performance over several days training, WT mice improve

faster (Moran et al., 1995; Nalbantoglu et al., 1997).
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David Adams Laboratory Overview

The Adams laboratory at WPI focuses on the use of neurotrophic factors (NTFs) as a
potential treatment for AD. NTFs function during normal development to help nerve cells
survive and divide when the nervous system is initially forming. So, it is hypothesized that the
use of such factors may facilitate neuronal survival during AD. However, full-length NTFs do
not efficiently cross the blood-brain barrier (BBB) when injected intravenously, intra-
peritoneally, or when taken orally, so our lab’s approach is to use short peptide fragments that
mimic the action of full-length NTFs.

Our laboratory specifically focuses on the neurotrophic factor ependymin (EPN). EPN
has been previously shown to be up-regulated in goldfish brains after performing a series of
training and learning events (Benowitz & Shashoua, 1997). EPN has multiple functions,
including facilitating optic nerve elongation and hippocampal long-term memory formation.
After being characterized in mice, monkeys, and humans (Adams & Shashoua, 1994; Adams et
al., 1996, Apostolopoulos et al. 2001), EPN became a major interest in our lab as a possible
treatment for neurodegenerative disorders. Our laboratory has shown that goldfish EPN peptide
mimetics CMX-8933 and CMX-9236 induce neuroprotection both in vitro (Adams et al., 2003)
and in vivo (Sashoua et al., 2003; 2004), and can upregulate anti-oxidative enzymes SOD-1,
catalase, and glutathione peroxidase (Shashoua et al., 2003; 2004). We also showed that treating
human neuroblastoma cells in vitro with AR followed by goldfish EPN mimetics partially
restores cell viability (Stovall, 2006), lowers caspase activation (Kapoor, 2007), decreases tau
hyper-phosphorylation and TUNEL staining for apoptosis (Ronayne, 2008), and lowers
cathepsin-D activity (Donahue and Lobdell, 2011). Recently, our laboratory showed that

treatment of cultured human SHSY neuroblastoma cells in vitro with a short human ependymin
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(hEPN) neurotrophic factor mimetic increases neuronal cell survival and increases cellular levels

of anti-oxidative superoxide dismutase (SOD-1) (Jackson and Najem, 2012).
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PROJECT PURPOSE

Although our lab has shown that neurotrophic factor mimetics can restore neuronal
survival against an AB challenge in vitro, we have not yet shown whether the NTF treatment
improves mouse behavior in an AD model. The purpose of this MQP is to develop the procedure
for performing the Morris water swimming test in-house at WPI, and determine whether this test
can distinguish the behavior of WT from 3X transgenic AD mice at 4 months of age, an age that
is one month past the published age at which they first begin to show cognitive decline. In
addition, an in vitro model for AD, in which cultured human SHSY neurons are treated with a
variety of AR batches, will be used to compare the changes in cell morphology, as part of the

initial phase of identifying potential NTF peptides to test in vivo.
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METHODS

AD Mouse Model

Homozygous 3X transgenic AD mice were purchased from The Jackson Laboratory
(strain #034843-JAX; stock number 007027). This strain is a triple transgenic, containing three
early-onset mutations in the human transgene. The mutations lead to high levels of neurotoxic
AP production when that peptide is cleaved inappropriately from the APP protein. AD female
mice were bred to AD male mice in-house at WPI to produce AD offspring for testing. The WT
mice were also purchased from The Jackson Laboratory (stock number 000664). This strain has
the same C57 genetic background as the selected AD mice. WT males were bred to WT females
in-house at WPI to produce WT offspring for comparison to age-matched AD mice. All pups
were aged to 4 months to allow the cognitive decline to initiate, while leaving them young enough to

swim well. 3 WT males, 2 WT females, 3 AD males, and 2 AD females were used in this study.

Morris Water Swimming Test

All tests were performed during the animal’s light cycle phase of the day. Food and water
were provided in the animal’s cages throughout the entire experiment ad libitum. The water tank
consists of a circular pool (120 cm diameter x 76 cm height) filled with water. The goal platform
for the mice to escape onto was a 10 cm x 10 cm square made of Plexiglas. The water was kept
at room temperature during all testing, and when changed was allowed to warm overnight to
room temperature. The pool was divided geographically into four quadrants, with four
equidistant mouse release points on the peripheral edge of each quadrant. Various cues were

placed on the walls outside the maze, and all trials were video recorded from above the pool for
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later analysis. The software records the time required to locate the platform and the total
distance travelled.

Animals were monitored at all times they were in the pool. Any test in which a mouse
became submerged was immediately terminated by removing the mouse from the pool. All mice
were placed for 45 seconds into a clean cage with dry towels between each trial. The pool water

was drained and cleaned after every 3-4 days of testing. Three types of tests will be performed:

Test-1 Test-2 Test-3
Visible Platform Unmarked Platform Probe
Testing Testing Trial
Testing Day: 1 2 3 4 5 6 7 8 0

Test-1: Visible Platform (Cued) Testing

On days 1-3, visible platform tests will be performed. In this portion of the testing, the
platform was positioned halfway between the pool wall and the pool center in one of the four
quadrants, and positioned flush with the water surface (visible). Fixed Platform Location: The
platform remained in the same position throughout this portion of the tests. Release Points: the
starting points of each of four trials per day (see below) varied; the starting points consisted of
each of the four possible release points (on the edges of each tank quadrant) in random order
(two of the start points are relatively close to the platform, and two are slightly further from the
platform). Using all four release points ensured that no mouse was released from the same point
on the same training day (which would give it an unfair advantage). Using different release
points forced each mouse to use visual cues to locate the platform. Four trials were conducted
per day for three days. The trial was started by the handler placing the mouse gently into the

water from the start site, and the trial ended by either the mouse climbing onto the platform or by
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a 90 second timeout if the mouse could not locate the platform. In the case of the timeout, the
mouse was gently placed onto the platform. All mice were left on the platform for 15 seconds to
help teach them the location of the platform, prior to being towel dried and placed in a clean
holding cage for 45 seconds between trials.

Test-1 is a relatively simple swimming task to locate a visible platform, and any
problems observed here would suggest impairment of motor function or a decrease of simple

cognitive processing.

Test-2: Unmarked Platform Testing

On days 4-8, unmarked platform testing was performed. This tested their ability to locate
a submerged platform, which requires a functional hippocampus for efficient performance. Five
days of testing were conducted with four acquisition trials per day. Platform Location: The
platform was located 0.5 cm underwater and remained in the same quadrant of the pool for all
testing. Release Points: As before, the mice were released from each of the four possible
release points on the edge of the tank in random order. After reaching the platform, mice were
allowed to remain on the platform for 15 seconds. If the mice failed to reach the platform within
90 seconds, they were gently placed on the platform for 15 seconds. As before, between trials,

the mice were placed in a clean cage with dry towels for 45 seconds.

Test-3: Probe Trial
On day-9, one probe trial was conducted the day after the last unmarked platform trial.
For the probe trial, the platform was completely removed from the tank, and the animal’s search

behavior was recorded. The amount of time spent swimming in each quadrant was monitored for
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90 seconds as an index of memory retention. High functioning mice should spend the most
amount of time in the quadrant previously containing the platform during the unmarked tests.
Mice will either be timed out at 90 seconds, or will be immediately removed if they cannot
swim.

Notes on Mouse Safety During Behavioral Tests:

1. Water Temperature: The water used for swimming was room temperature. The temperature
was tightly controlled inside the Vivarium where the tank was placed.

2. Experiment Termination: If any mouse could not keep his nose above water, it was
immediately retrieved from the water, and not tested further in any experiments.

3. Time-Out Period: The maximal swimming time was 90 seconds for any trial. 1f a mouse
could not locate the platform in 90 seconds, it was placed on the platform and left there for
15 seconds (to help it remember the location). Published protocols use a maximum of 1-2
minutes for the time-out. We chose 90 seconds (towards the upper limit) to help display a
difference between WT and AD mice.

4. Rest Period Between Trials: All mice were rested 45 seconds between trials in a clean dry
cage with toweling. Published protocols vary widely for the rest period, from 30 seconds
to 20 minutes. We chose 45 seconds to allow a brief rest, as we wish to push the mice
here to help distinguish WT from AD mice.

5. Water Cleaning: The pool was drained and cleaned after every 3-4 days of testing.

Morris Water Maze Computer Program

The Morris Water Maze system was purchased from Coulbourn Instruments, and was run
in accordance with their manual with a few adjustments. The WPI system was set up in the
Vivarium on the second floor of WPI’s Life Sciences and Bioengineering Center. Since the
system and experiment was new to WPI, troubleshooting had to be done to adjust the system to
the facility. To summarize and clarify the instructions for running the maze, a small tutorial can
be found below as well as a screenshot of the programs analysis functions (Figure-3).

Using the WaterMaze Software
1. Log on to computer
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= Username: staff
= Password: staff123
2. Make sure camera is plugged in
3. Test camera in STCamSW
4. Open WaterMaze software and open an existing project or make a new project

= To open an existing experiment: Project - Open then select the project file you
would like to open

= To create a new project: Project > New
e Adjust the number of animals in your new project by using the arrows
next to the # of Animals box on the screen
e Adjust the number of days in your new project by using the arrows next to
the # of Days box on the screen
¢ Adjust the number of trials per day by using the arrows next to Trials box
for each day (NOT the # of Sets/Day box)

= Save your new project: Project = Save As — then type in a file name for your project
and press OK

5. Check pool and platform settings
= For pool go to: Settings = Pool
e Here you can adjust the pool diameter and move the pool outline to match
the camera image
¢ You can adjust the pool size/location by clicking and dragging the left and

right edge of the outline. Use this to match up pool outline to the water in
the camera image.

= For platform go to: Design - Platforms
e Here you can adjust the size and location of the platform
¢ To adjust platform size use the arrows next to the platform size box on the
screen

¢ To adjust platform location click in the center of the platform and drag it
to the desired location
6. Run atrial

= Switch to Run Mode: Mode = Run — this will bring up the trial run screen
= Select atrial
e To run the next trial in an experiment click Run Next

e To run a particular trial select the trial in the trial list and then click Run
Selected

= The pool image will come up — ensure that the pool outline and platform are properly
located

= When you are ready to start the trial press Reference

= When the trial has ended press SAVE and the software will automatically bring you
back to the trial run screen
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7. Analysis

There are two different analysis screens — the Export Analysis Screen and the View
Analysis Screen
The Export Analysis Screen can be found by pressing Analysis = Export from the
trial run screen
e In the Export Analysis screen you can export an Excel data file that has
the project data for each animal, day, and trial.

1. To create a file with data from all the trials from all the animals in
the project you first need to select all of the animals and all of the
trials. Do do this click Select > All Animals — All Trials

2. To create a file with data from all the trials from only a selected
animal in the project click Select > Selected Animal — All Trials

3. To export the Excel file click Export Analysis = To File and enter
a name for the Excel file. Click OK to save the file.

4. To view this Excel file of the exported project data click the
Windows Start button - My Documents > the file you just
created (it will appear as “file name”.csv)

e In the Export Analysis Screen you can also view the density plots for each
trial

1. Select a trial in the project by clicking on it in the trials list

2. Click Density Plots = View to view the density plot for that trial

¢ To exit the Export Analysis Screen click File = EXxit — this will bring you
back to the trial run screen
The View Analysis Screen can be found by clicking Analysis = View from the trial
run screen
e In the View Analysis Screen you can see images of the paths taken in each
trial

1. View path images for each trial by clicking on the trial in the trials

list
e You can also view path videos from the View Analysis Screen

1. View path videos for each trial by double-clicking on the trial in
the trials list.

2. This will bring up a separate window where you can watch a video
of the trial overlaid with the path

3. To exit the video screen click File > Save & Exit

e To exit the View Analysis Screen click File = Exit — this will bring you
back to the trial run screen
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Figure-3: Morris Water Maze Analysis Screenshot.

The complete manual of the software can be found on the company’s website:

http://www.coulbourn.com/v/vspfiles/assets/manuals/ACT-200%20WaterMaze%20Manual.pdf

Human SH-SY5Y Cell Culture

Human SH-SY5Y neuroblastoma cells (commonly termed SHSY) were obtained from
liquid nitrogen stocks previously obtained from ATCC and expanded in our laboratory.
The culture medium was prepared in a 500 mL bottle by adding together 500 mL DMEM-F-12
(ATCC), 50 mL of FBS (Hyclone) (to give a final concentration of 10%), and 0.275 mL of 10
mg/mL gentamycin (Gibco) (to make give a final concentration of 5 pg/mL). The mixture was

filter sterilized using a 0.2 um filter and stored at 4°C.
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SHSY cells were thawed from liquid nitrogen storage and placed in a 37°C water bath for
1-2 minutes until completely thawed. The vial was wiped down with reagent alcohol, and the
cells were carefully re-suspended and transferred to a T-25 flask containing 4 mL of pre-warmed
culture medium. The flask was placed in a 37°C + 5% CO, humidified incubator. After 24 hours
of incubation, the spent medium was siphoned and replaced with fresh, pre-warmed medium.

The cell cultures were fed every 3-4 days until the flasks achieved approximately 80%
confluency or above. To feed the cell cultures, the old medium was aspirated and replaced with 4
mL of fresh, pre-warmed medium. Once the cells reached a confluency of 80% or above, the
cells were split 1:2 (never greater than this) into new flasks. To split the cultures, the old medium
was aspirated and replaced with 8 mL pre-warmed medium and the flask was scraped to release
the cells from the floor of the flask. The cells were then re-suspended and 4 mL of the
suspension was pipetted into each of two new flasks.

Splitting the cells greater than 1:2 was found to decrease the cell density low enough to
enter a lag phase of growth. Flasks that were at low density were pooled together and replaced
with fresh complete medium. Additionally, splitting the cells for a long time can cause the cells
to attach in clumps and in several layers, making it difficult to get an accurate count of cells. In
order to break apart clumps, 1 mL of trypsin was added to the cell flask, placed in the 37°C
incubator for 2-3 minutes, and then 5 mL of complete medium was added to neutralize the
trypsin. The cells were plated overnight, and the medium was replaced the following day. Using
trypsin might send the cells into a slightly longer lag phase of growth.

When a T-25 flask was 90% confluent, the cells were frozen down by siphoning off the
spent medium and replacing it with 1 mL of pre-warmed freezing medium (Gibco). The cells

were scraped and re-suspended, then pipetted into a cryovial, and stored overnight at -80°C in a
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Styrofoam® rack for insulation to slow the freezing process. After 12-24 hours, the cells were
moved to liquid nitrogen storage.

For plating experiments, T-25 flasks that were 80% or above confluent (3 plates) were
split and plated onto six T-25s. For A treatment conditions, four different 1.0 mM A batches
dissolved in 1 mM Sodium Bicarbonate were introduced to the flasks at a final concentration of
20 uM (80 pL of 1 mM stock per 4 mL medium). The AB-treated flasks were cultured up to 72
hours, at which point cells were subjected to morphology cell counts. Untreated, control flasks

generally reached approximately 80% confluency after 72 hours.

Cell Morphology Counts

Twelve representative regions of each experimental flask were imaged at 72 hours post-
plating by a Leica inverted microscope and camera attachment at 10x magnification. Images
were used to count unconnected neurons (solo stellate cells), dying cells (solo non-stellate cells),
and total cells per viewing field. Counts from all twelve representative regions of each flask

were averaged.
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RESULTS

The purpose of this project was to establish a procedure for performing the Morris water
swimming test in-house at WPI, and to determine whether this test can distinguish between WT
and 3X transgenic AD mice at 4 months of age, an age that allows the cognitive decline to
initiate while leaving them young enough to swim well. Additionally, cultured human SHSY
neuronal cell cultures were tested with a variety of AP peptide batches as an initial step towards

helping identify NTF candidates for testing in vivo.

In Vitro Alzheimer’s Model Testing With Several Ap Batches

Our laboratory previously demonstrated that adding AP to human SHSY neuroblastoma
cells in culture is an effective in vitro model of AD. The AP increases neuronal cell death
(Stovall, 2006), increases caspase-3 activation levels similar to AD patients (Kapoor, 2007),
increases tau hyper-phosphorylation as in AD (Ronanyne, 2008), increases apoptotic TUNEL
staining (Ronayne, 2008), and increases cathepsin-D activity levels (Donahue and Lobdell,
2011). When simultaneously adding an NTF mimetic with the AP, all these effects decreased.
This in vitro system was used in this project to test a variety of AP batches, as a prelude for
identifying NTF peptides for testing in vivo.

To compare the activity of a variety of AP batches on cell morphology, an in vitro assay
was set up using an SHSY human neuronal cell line. At the time of flask splitting, four flasks
received 20 uM of one of the four AP batches, while the fifth flask was left untreated as a

control. The five flasks were imaged after 72 hours using a Leica inverted microscope
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microscope and camera attachment. The images were divided into twelve regions to count the
total number of cells, number of unconnected neurons, and the number of dying cells (Figure-7).
All four AB batches showed the desired effect of a significant (p < 0.001) decrease in total
human neuronal cell numbers, and a significant increase (p < 0.001) in unconnected neurons in
two of the AP treatments and a slight increase (p < 0.05) in the other two. The dying cell data

was inconclusive for this experiment.
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Figure-7: All Four Ap Batches Tested Strongly Affect Human Neuronal Cells. Cell
morphology determinations after 72 hr treatment with AB. A) Average (N=12) of total
raw cell counts. B) Average (N=12) of unconnected neurons (solo stellate) raw cell
counts. C) Average (N=12) of dying cells (solo non-stellate) raw cell counts. Each
histobar represents the average of twelve representative regions of one experimental
flask. * p<0.05. ** p<0.001.
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Morris Water Maze Test of Mouse Cognitive Performance

As described in the Methods section, the swimming behaviors of 5 AD mice and 5 WT
mice were observed using a camera placed above a water tank. In the first three days of testing
(cued test), the platform was raised to the water surface and marked with black tape. The visible
cue was removed and the platform slightly submerged during the next five days of testing
(unmarked or non-cued test). Then on the last day of testing (probe test), the platform was
completely removed from the tank. The time it took for each animal to locate the platform, the
length of swimming, and the time spent in each hemisphere were recorded. Figure-4 shows

example swimming paths recorded by the WaterMaze program.

Figure-4: Selected Mouse Swimming Density Graphs. Shown are typical swimming
graphs for WT mice (A, B) and AD mice (C, D) for unmarked trial day-1 (A, C) and day-
5 (B, D). Note the reduced swimming path for WT mice after 5 days of training (B).

31



In phase-1 cued tests using a visible platform, all mice improved their time to locate the
platform over the 3 days of training (Figure-5A). Surprisingly, the WT mice (blue curve)
appeared to take slightly longer to locate the platform than AD mice (red curve). Statistical
differences between WT and AD mice were observed on Day 2 and Day 3 (p < 0.05 single
asterisks). The mice slightly increased their time spent in the target hemisphere, with AD mice
performing slightly better than WT mice (Figure-5B). After 5 days of testing with the unmarked
platform, all mice showed a slight improvement in time to platform (Figure-5C). No statistical
difference was observed between WT and AD mice. WT mice increased their time spent in the
target hemisphere containing the unmarked platform, while AD mice spend a decreased amount

of time in the target hemisphere (Figure 5D).
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Figure 5: AD Mice At 4 Months of Age Are Indistinguishable from WT Mice in a
Morris Water Maze test. WT and AD mice were tested over a three day period using a
marked platform (A and B) and then over a five-day period using an unmarked platform
(C and D). A) Average time to locate marked platform over three days. B) Average
percentage of time spent in the target hemisphere containing the marked platform. C)
Average time to locate the unmarked platform. D) Average percentage of time spent in
the target hemisphere containing the unmarked platform.

On day-9 of the tests, the platform was removed (probe test) and the amount of time the
mice spent in the target hemisphere (where the platform used to reside) was tracked (Figure-6).
All mice spent more time in the correct location, with WT mice (blue) and AD mice spending

approximately equal time in the correct area (Figure-6).
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Figure-6: Probe Test. WT mice (blue) and AD mice (red) spend about equal
amounts of time in the target hemisphere (previously containing the platform) during
the probe trials.
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DISCUSSION

This project extended our laboratory’s previous in vitro and in vivo AD experiments by
setting up the Morris water maze test in-house at WPI. Previous research in our lab showed that
treating human neuroblastoma cells in vitro with AP followed by goldfish EPN mimetics
partially restores cell viability (Stovall, 2006), lowers caspase activation (Kapoor, 2007),
decreases tau hyper-phosphorylation and TUNEL staining for apoptosis (Ronayne, 2008), and
lowers cathepsin-D activity (Donahue and Lobdell, 2011). Recently, treatment of cultured human
SHSY cells with a short human ependymin (hEPN) neurotrophic factor mimetic increased
neuronal cell survival and increased cellular levels of anti-oxidative superoxide dismutase (SOD-
1) (Jackson and Najem, 2012) following AP treatment. This MQP extended these studies by
setting up a mouse behavioral test in-house at WPI that will eventually be used to determine

whether NTF mimetics can improve mouse behavior.

In Vitro Alzheimer’s Model

Our lab’s in vitro neuronal cell morphology assay was used to test four different Ap
batches. After 72 hours of treatment, each batch showed significant (p<0.001) cell morphological
alterations relative to control cultures, indicating the AB is chemically active. It would have been
interesting to monitor the changes in cell morphology at each day of treatment, but the 72 hr time
point was used by our lab in the past. The next step would be to use the AR samples in the in
vitro model to test the activity of a variety of NTF mimetics, and then test the most active NTF in

the in vivo model.
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Morris Water Maze Test

Previously, several researchers have attempted to use a variety of behavioral assays to
distinguish WT and AD mice, including using the Y-maze, Rotarod, Elevated Plus-Maze test, and
others. However, several of the tests show minimal differences between AD and WT mouse
behavior, suggesting the assays cannot easily differentiate the two groups. However, one study
in particular used transgenic female mice homozygous for human -APP and showed the Morris
water maze test to be effective in distinguishing AD and WT mice (Moran et al., 1995).

In our tests, the data indicated that at 4 months of age, this strain of AD mice show a
behavior that is generally indistinguishable from WT mice. The marked platform trials showed a
significant difference that AD animals perform slightly better than WT animals. On all three
days of marked trials, the AD mice located the platform faster, although the R? slope of the WT
mice is higher than that of the AD indicating a steeper learning slope. Several theories could
explain this data. This may reflect the low sample number of mice tested, their young age in
which hippocampal degeneration is not yet significant, or we may need a different AD mouse
strain. In a study conducted by Garcia-Osta and Alberini (2009), researchers showed AB-42 in
low concentrations when injected into rats appears to mediate memory formation and
enhancement. This indicates that elevated levels of AR may increase brain function initially
before the higher levels begin to cause neurodegeration. Also, since AD mice can show erratic
behavior it could be that they are swimming faster covering a greater area over the given time.

In the unmarked platform trials, there was no statistical difference between WT and AD
mice. It was hypothesized that WT mice would locate the platform more quickly due to the
cognitive deficit of AD mice. Again the R* value was higher for the WT mice indicating a

steeper learning slope.

36



In the probe trials, where the platform was completely removed from the tank, both AD
and WT mice spent more time searching for the platform in the correct target hemisphere (where
the platform used to reside), and the WT spent about the same time in the target hemisphere as
the WT mice.

Using the WaterMaze system from Coulbourn Instruments required troubleshooting
several problems. When originally setting up the system, it we learned that is important to
perform several steps not found in the manual. Lighting in the room is an important factor in
getting accurate measurements. Glare from lights on the water will interfere with the tracking
software and prevent the tracking of the test animal. By covering overhead lights and adjusting
the light settings in the camera software, this problem can be solved. Also, if problems still
occur, adjusting the setting on the removable camera lens can remedy it.

Setting up an experiment in the Coulbourn software requires centering the platform in the
quadrant of interest. In the platform setup menu, the camera view of the tank will be visible as
well as an adjustable setting for the water maze and four lines dividing the tank. These are not
the dividers for the quadrants but rather these indicate the diagonals for the quadrants. When
orienting the platform, these lines indicate the center of the quadrants and are helpful for accurate
placement.

When running a trial, timing is the hardest factor to compensate for. The reference frame
should be taken with no obstacles in the frame of the camera. Any movement or change in the
image (such as the experimenter’s shadow) will disrupt the tracking software. Once in the
reference frame, but before the start button is pressed, the experimenter should prepare to place
the mouse in the appropriate drop site, and have some way to dry the mouse after the trial. As

quickly as possible the experimenter should gently place the mouse in the tank and move out of
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frame before the video begins to record the animal’s swimming path. To allow time for the
experimenter to get out of frame, the mouse can be gently placed in the tank facing the tank wall.
Once the experimenter is clear, the start button should be pressed and the trial can be run as the
protocol prescribes.

Future experiments include aging the AD mice to 6 months, using a larger sample size,
possibly trying a different AD genetic strain, and trying a different behavioral test, such as the

Novel Object Recognition test.
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